
OneFlow™ Chronic Lymphoproliferative
Diseases Limited Panel

BD OneFlow™ LST—Catalog No. 658619—20 Tests

BD OneFlow™ B-CLPD T1—Catalog No. 659293—20 Tests

23-15586(06)
2022-06
English

1. INTENDED USE

The BD OneFlow™ tubes for chronic lymphoproliferative diseases (CLPD) are intended for in vitro diagnostic
use as a panel of fluorochrome-conjugated antibodies for qualitative flow-cytometric immunophenotyping of
mature lymphocyte populations on a BD flow cytometer equipped with:

• A 488-nm blue laser, a 640-nm red laser, and a 405-nm violet laser
• The ability to detect forward scatter (FSC) and side scatter (SSC)
• At least eight-color fluorescence
• Software to acquire and analyze the data
These reagents are used as an aid in the differential diagnosis of hematologically abnormal patients having,
or suspected of having, B-cell CLPD, T-cell CLPD, and NK-cell CLPD. These tubes can be used with peripheral
blood and bone marrow specimens collected in EDTA or heparin tubes and lymph node specimens. The results
should be interpreted by a pathologist or equivalent professional in conjunction with other clinical or
laboratory findings.

The BD OneFlow™ CLPD Limited Panel comprises the following BD OneFlow™ tubes:

• BD OneFlow™ LST (Lymphoid Screening Tube)
• BD OneFlow™ B-CLPD T1 (B-cell Chronic Lymphoproliferative Disease Tube 1)
These reagents provide multi-parameter, qualitative results for the antigens listed in Table 1.

FITC PE
PerCP-
Cy5.5 PE-Cy7 APC APC-H7 V450 V500-C

LST CD8
and Igλ

CD56
and Igκ

CD5 CD19
and

TCRγ/δ

CD3 CD38 CD20
and
CD4

CD45

B-CLPD T1 CD23 CD10 CD79b CD19 CD200 CD43 CD20 CD45

Table 1 Antigens targeted by the BD OneFlow™ CLPD Limited Panel tubes

2. SUMMARY OF THE TEST

In chronic lymphoproliferative diseases (CLPD), clonogenic events lead to the expansion and accumulation of
mature-appearing lymphocytes, which carry a proliferative and/or survival advantage over their normal
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counterparts.1 Thus, the detection of phenotypically abnormal and clonal mature lymphocytes is critical to the
diagnosis of CLPD. BD OneFlow™ LST can distinguish hematologically abnormal B cells, T cells, and NK cells
from their normal counterparts.

The sample acquisition can be automated using the optional BD FACS™ Universal Loader when used with the
BD FACSLyric™ flow cytometer. This assay is not for automated sample preparation. Data analysis can be
performed using a pre-defined template and gating, however, reviewing all plots and adjusting gating
manually by the user are recommended.

Principle of Operation

The reagents in the BD OneFlow™ CLPD Limited Panel are composed of monoclonal antibodies, each
conjugated to a specific fluorochrome. The specimen is added to the reagent tube and incubated, allowing
each fluorochrome-conjugated monoclonal antibody in the reagent to bind to a specific antigen on the
surface of the cells. After incubation, BD FACS™ Lysing Solution is added to lyse the red blood cells in the
sample. Cells are acquired on a BD flow cytometer using the instrument software. During acquisition, the cells
travel past the laser beam and scatter the laser light. The stained cells fluoresce. These scatter and
fluorescence signals, detected by the instrument, provide information about the cell’s size, internal complexity,
and relative fluorescence intensity. The instrument software is used to analyze the data and report the result.

3. REAGENT

Reagent Composition

The reagents consist of single-use tubes containing the following fluorochrome-conjugated antibodies in an
optimized dried formulation. All of the antibodies have IgG1 heavy chains and kappa light chains with the
exception of CD5, which has IgG2a heavy chains and kappa light chains. The antibody clone names are shown
in the following table in the row beneath the antibody.

Reagent FITC PE
PerCP-
Cy5.5 PE-Cy7 APC APC-H7 V450 V500-C

LST

CD8 CD56 CD5 CD19 CD3 CD38 CD4 CD45

SK12 MY313,4 L17F125,6 SJ25-C17,8 SK76 HB77 SK32 2D19,10

Anti-Lambda Anti-Kappa – Anti-TCRγ/δ-
1

– – CD20 –

1-155-211 TB28-211 – 11F212,13 – – L277 –

B-CLPD T1

CD23 CD10 CD79b CD19 CD200 CD43 CD20 CD45

EBVCS-5 8,14 HI10a15 SN816 SJ25-C1 MRC OX-
10417,18

1G1019 L27 2D1

BD Horizon™ V450, BD Horizon™ V500-C

Table 2 Antibody composition of BD OneFlow™ LST and BD OneFlow™ B-CLPD T1

The antibodies in BD OneFlow™ LST were chosen for their ability to separate normal lymphocytes into their
major subpopulations and to distinguish hematologically abnormal B cells, T cells, and NK cells from their
normal counterparts.
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The antibodies in BD OneFlow™ B-CLPD T1 were chosen to work in conjunction with the antibodies in
BD OneFlow™ LST to distinguish CLL from other B-cell chronic lymphoproliferative diseases in patient
specimens.

Refer to the article describing the EuroFlow antibody panels1 for a full description of the utility of the
antibodies chosen for the reagents.

Precautions
• The reagents contain 2-methyl-4-isothiazolin-3-one. These reagents are classified as hazardous according

to the Globally Harmonized System of Classification and Labelling of Chemicals (GHS) and Regulation (EC)
No 1272/2008. Go to regdocs.bd.com/regdocs/sdsSearch to download the Safety Data Sheet.

Warning

H317: May cause an allergic skin reaction.
H412: Harmful to aquatic life with long lasting effects.

Prevention P261: Avoid breathing dust/fume/gas/mist/vapors/spray.
P272: Contaminated work clothing should not be allowed out of the workplace.
P280: Wear protective gloves/protective clothing/eye protection/face protection.
P273: Avoid release to the environment.

Response P302+P352: IF ON SKIN: Wash with plenty of water.
P333+P313: If skin irritation or rash occurs: Get medical advice/attention.
P321: Specific treatment (see Safety Data Sheet).
P362+P364: Take off contaminated clothing and wash it before reuse.

Disposal P501: Dispose of contents/container to an appropriate treatment and disposal facility in accordance
with applicable laws and regulations, and product characteristics at time of disposal.

Storage and Handling
• Store tubes at 2–27 °C in the foil pouch.
• Do not freeze the reagent or expose it to direct light at any time during storage or incubation with cells.
• The dried fluorochrome-conjugated antibodies are stable until the expiration date shown on the pouch and

tube labels when stored as directed. Do not use after the expiration date.
• Once the pouch is opened, the dried fluorochrome-conjugated antibodies are stable for 1 month when

stored as directed.
CAUTION Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch.

4. INSTRUMENTS

The recommended BD systems are outlined in the following table. See the corresponding reagent or
instrument user documentation for details.

3

http://regdocs.bd.com/regdocs/sdsSearch


Flow cytometer Setup beads Setup software Analysis software

BD FACSLyric™a BD® CS&T Beads
BD® FC Beads 7-Color Kit
BD® FC Beads 5-Color Kit
BD® FC Beads 2-Color Kit
(12-color instrument)

BD FACSuite™ Clinical
application v1.4 or laterb

BD FACSuite™ Clinical application
v1.4 or later

BD FACSCanto™ IIc BD FACSDiva™ CS&T
IVD Beads
BD OneFlow™ Setup
Beads
BD® FC Beads 8-Color Kit
for BD OneFlow™ Assays

BD FACSDiva™ software v8.0.1 or
later

BD FACSDiva™ software v8.0.1 or
later

a. 8-color (4-Blue 2-Red 2-Violet), 10-color (4-Blue 3-Red 3-Violet), or 12-color (4-Blue 3-Red 5-Violet)

b. The Loader can be used withBD FACSuite™ Clinical application v1.5 or later

c.  3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical configuration

Table 3 Recommended BD systems

The BD FACS™ Universal Loader can be used with these products. See the BD FACSLyric™ System Instructions
For Use for more information. The Loader can be used with BD FACSuite™ Clinical application v1.5 or later.

5. SPECIMEN COLLECTION AND PREPARATION

The reagents can be used for immunophenotyping by flow cytometry of peripheral blood (PB), bone marrow
(BM) aspirates, or lymph nodes (LN).

• Collect PB specimens aseptically by venipuncture in BD Vacutainer® K2 or K3 EDTA blood collection tubes,
or equivalent, or in lithium or sodium heparin.20

• Collect BM specimens in BD Vacutainer® K2 or K3 EDTA blood collection tubes, or equivalent, or in lithium
or sodium heparin.

• Collect LN specimens in phosphate buffered saline (PBS), PBS-soaked gauze, or cell culture media, such as
RPMI.
We recommend that you follow guidelines described in consensus protocols for flow cytometric
immunophenotyping of hematopoietic malignancies.21,22

• PB and BM specimens should be processed up to 24 hours after collection.

Specimens with large numbers of nonviable cells can give erroneous results due to selective loss of
populations and to increased nonspecific binding of antibodies to nonviable cells. Viability of specimens
should be assessed. A minimum viability of 75% is recommended.23

• Samples should be acquired within 60 minutes of staining if kept at room temperature, protected from
light.

WARNING     All biological specimens and materials coming in contact with them are considered biohazards.
Handle as if capable of transmitting infection24,25 and dispose of with proper precautions in accordance with
federal, state, and local regulations. Never pipette by mouth. Wear suitable protective clothing, eyewear, and
gloves.

Interfering Conditions

Substances present in the specimen might interfere with the assay:
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• Use of therapeutic monoclonal antibodies in patient treatment, such as Rituximab and Alemtuzumab, can
interfere with recognition of target antigens by this reagent or deplete the clinically relevant cell
populations. This should be considered when analyzing samples from patients treated in this fashion. BD
Biosciences has not characterized the effect of the presence of therapeutic antibodies on the performance
of this reagent.

• Avoid using potentially compromised specimens, including clotted, hemolyzed, frozen, or refrigerated
specimens.

6. PROCEDURE

Reagents and Materials

Reagents and materials provided

The reagents are provided as single-use tubes in foil pouches. Each kit contains four pouches, each containing
five tubes of dried reagent.

Reagents and materials required but not provided
• BD OneFlow™ Assays Installer I (Catalog No. 664225)

An installer is required to use the BD OneFlow™ reagents with BD FACSuite™ Clinical application. The
assays installer includes an acquisition sheet, a laboratory report, a physician report, and a supplemental
report used for sample analysis and results reporting. Unless you already have the current BD OneFlow™
Assays Installer, you will have to order the installer the first time you order the reagent.
The BD OneFlow™ Application Guide for Chronic Lymphoproliferative Diseases for BD FACSLyric™ Flow
Cytometers is provided with the installer.

• BD OneFlow™ Assay Templates Installer (Catalog No. 659305)
An installer is required to use the BD OneFlow™ reagents with BD FACSDiva™ software. The templates
installer includes two global worksheets: the BD OneFlow™ Acquisition worksheet and the BD OneFlow™
Analysis worksheet. Unless you already have the current BD OneFlow™ Assay Templates Installer, you will
have to order the installer the first time you order the reagent. The installer also contains the OneFlow
Setup template.
The Instrument Setup Guide for BD OneFlow™ Assays, the BD OneFlow™ LST Application Guide, and the
BD OneFlow™ Application Guide for B-cell Chronic Lymphoproliferative Diseases are provided with the
installer.

• BD FACS™ Lysing Solution (10X) (Catalog No. 349202)
See the BD FACS™ Lysing Solution instructions for use (IFU) for precautions and warnings.

• 15-mL or 50-mL conical polypropylene tubes
• 40-μm cell strainer (for processing BM and LN specimens)
• 1 cc or 3 cc syringe (for processing LN specimens)
• Pasteur pipette
• Serological pipette
• Micropipettor with tips
• Vortex mixer
• Centrifuge
• Wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium azide)
• (Optional) BD FACS™ Universal Loader
NOTE Labs must validate any deviations from the following procedures.
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Installing the Assay or Template

The BD OneFlow™ Assay Installer, used with BD FACSuite™ Clinical application, or the BD OneFlow™ Assay
Template Installer, used with BD FACSDiva™ software, has to be installed before you run the assay for the
first time. Additional assays or templates can be installed at the same time, as needed. If you will analyze the
FCS files on a different workstation from the one used to acquire the samples, ensure that you install the
assays or templates on both workstations.

To install the BD OneFlow™ assay in BD FACSuite™ Clinical application:

NOTE When you select an assay to install, it will overwrite the BD OneFlow™ assay that was previously
installed on the system. If you do not want an existing assay on your computer to be overwritten, do not
select that assay from the installer during the installation process.
1. Insert the installer and click the installer icon.

The InstallShield Wizard for BD OneFlow™ Assays opens.
2. Click Next.

The license agreement opens.
3. Select the I accept the terms in the license agreement option and click Next.
4. To install all of the assays included on the installer, select the Complete option and click Next.
5. Optional: To install a subset of the assays included on the installer, select the Custom option and click

Next.
The Custom Setup dialog opens.
• Click the menu to the left of the appropriate assay.
• From the menu, select This assay will be installed on your local hard drive.

6. Click Install.
The assays will be installed in the Library.

7. Click Finish.
The InstallShield Wizard closes.

8. Optional: Double-click the ReadMe file found on the installer.
The ReadMe file opens.

9. Click the close box when finished reading it.
10. Remove the installer.
To install the OneFlow template in BD FACSDiva™ software:

NOTE When you select a template to install, it will always overwrite any template with the same name that
was previously installed on the system. If you do not want an existing template on your computer to be
overwritten, do not select that template from the installer during the installation process.
1. Insert the installer and click the installer icon.
2. Follow the instructions in the dialog.

The installer will copy and paste the templates in the folder
D:\BDExport\Templates\Panel\BD Panels.
NOTE If your system has only one drive, the templates will be installed in
C:\BDExport\Templates\Panel\BD Panels.
After installation is complete, a dialog opens, summarizing which templates have been successfully copied
into the folder.

3. Click OK to close the dialog.
4. The installer ReadMe file opens. Click the close box when you have finished reading it.
5. Remove the installer.
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Setting up the Cytometer

For BD FACSLyric™ flow cytometers:
1. Use BD® CS&T Beads and BD FACSuite™ Clinical application v1.4 or later, to perform Characterization QC

(CQC) every 6 months or as needed, perform daily Performance QC (PQC), and perform daily assay and
tube settings setup. For assay and tube settings setup, select the Run Setup and Generate Reports
checkboxes.

2. Use the BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD FACSuite™ Clinical application v1.4 or
later, to update reference settings every 60 days. In addition, use the BD® FC Beads 2-Color Kit to set up a
12-color instrument.
See the BD FACSLyric™ System Instructions For Use, the BD FACSLyric™ Clinical Reference System, and the
appropriate reagent IFU for more information.

For BD FACSCanto™ II flow cytometers:
1. Use BD FACSDiva™ CS&T IVD Beads (CS&T IVD beads) and BD FACSDiva™ software v8.0.1 or later, to

define the baseline of the cytometer and to run a daily performance check of the cytometer.
2. Use BD OneFlow™ Setup Beads, lysed washed blood, andBD FACSDiva™ software v8.0.1 or later, to set

photomultiplier tube (PMT) and scatter voltages monthly.
3. Use BD® FC Beads and BD FACSDiva™ software v8.0.1 or later, to set fluorescence compensation monthly.
4. We recommend that you confirm that the PMT voltages (PMTVs) are still within their daily target ranges.

See the Instrument Setup Guide for BD OneFlow™ Assays and the appropriate reagent IFU for more
information.

Diluting BD FACS™ Lysing Solution

Dilute the 10X concentrate 1:10 with room temperature (20–25 °C) deionized water. The prepared solution is
stable for 1 month when stored in a glass or high density polyethylene (HDPE) container at room
temperature.

Processing the Specimen

Washing the specimen

NOTE Before washing the specimen, confirm that the cytometer has been properly set up.
1. For each tube to be stained, label a 15-mL conical tube with the specimen ID.
2. Prepare each specimen type as described:
� For PB specimens, invert the collection tube 10 times to mix well.
� For BM specimens, invert the collection tube 10 times to mix well. Verify that the specimen is not lipemic
and does not have particulate matter in it.

– If needed, pass sufficient specimen through a 40-μm cell strainer.
� For LN specimens, if the specimen is not a single-cell suspension,

– Place LN in a 40-μm cell strainer set on a 15- or 50-mL conical tube.
– Gently disrupt the LN to obtain a single-cell suspension by pressing with the plunger of a 1 cc or 3 cc
syringe.
– Wash the cell strainer with wash buffer. Discard the cell strainer.
– If needed, centrifuge at 540g for 5 minutes at 20–25 °C. Remove the supernatant.
– Resuspend the cell pellet in an appropriate volume of wash buffer.

� Fine-needle aspirates (FNA) are ready for staining. There is no need to wash the specimen.
3. Add 300 μL of the specimen to each labeled conical tube.
4. Add 10 mL of wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium azide).
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5. Invert the tube 3–5 times to mix well.
6. Centrifuge at 540g for 5 minutes at 20–25 °C.
7. Remove the supernatant without disturbing the cell pellet.

NOTE If the cell pellet is disturbed, centrifuge the tube again and then remove the supernatant without
disturbing the cell pellet.

8. Vortex the tube until no cell aggregates remain in the residual wash buffer.
9. Repeat steps 7–11 twice for a total of three washes.

10. Resuspend the cell pellet in wash buffer to give a final volume of 300 μL.
11. Vortex vigorously 3–5 seconds to completely resuspend the cell pellet.

NOTE Start staining the specimen with the BD OneFlow™ reagent within 30 minutes of the last wash.
Store the washed specimen at 20–25 °C until you stain it.

Staining the specimen
1. If the pouch is stored refrigerated, allow it to reach room temperature before opening it.

NOTE The reagent is very sensitive to moisture. To avoid condensation, open the pouch only if it is at
room temperature.

2. For each patient specimen, remove a reagent tube from the pouch.
3. Place the tubes in a rack, protected from light.

Start staining the specimen within 1 hour of removing a tube from the pouch.
4. Immediately reseal the pouch with any unused tubes.

NOTE Ensure the pouch is completely resealed after removing a tube. The reagent is very sensitive to
moisture. Do not remove the desiccant from the reagent pouch. Use the tubes within 1 month of opening
the pouch.

5. Write the patient ID on the tube label within the area provided.
6. Vortex washed specimen 3–5 seconds to mix well.
7. Add 100 μL of washed specimen to the tube. Vortex vigorously 3–5 seconds to mix well.

If less than 100 μL of specimen is used, add wash buffer to a final volume of 100 μL.
NOTE Staining from 2.5 × 105 to 4 × 107 white blood cells/mL gives equivalent results.

8. Incubate for 30–35 minutes at 20–25 °C, protected from light.
9. Add 2 mL of 1X BD FACS™ Lysing Solution. Vortex 3–5 seconds to mix well.

10. Incubate for 8–12 minutes at 20–25 °C, protected from light.
11. Centrifuge at 540g for 5 minutes at 20–25 °C.
12. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 μL of residual liquid in

the tube.
13. Vortex vigorously until the cell pellet is completely resuspended.
14. Add 2 mL of wash buffer to the tube. Vortex 3–5 seconds to mix well.
15. Centrifuge at 540g for 5 minutes at 20–25 °C.
16. Remove the supernatant without disturbing the cell pellet, leaving approximately 50 μL of residual liquid in

the tube.
17. Vortex 3–5 seconds to resuspend the cell pellet.
18. Add 200 μL of wash buffer to the tube. Vortex 3–5 seconds to mix well.

NOTE Samples should be acquired within 60 minutes if kept at room temperature, protected from light.

Setting up the Assay (BD FACSLyric™ Flow Cytometer)

To add a reagent lot ID and expiration date to the library:

1. From the BD FACSuite™ Clinical application navigation bar, click the Library icon.
The Library workspace opens.

2. Expand the Beads and Reagentsmenu and select Reagents.
3. Select the appropriate BD OneFlow™ reagent from the Product Name list.
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The OneFlow reagent pane opens at the bottom of the page.
4. Click Add Lot.

The Add New Lot dialog opens.
5. In BD FACSuite™ Clinical application v1.5, click Scan Barcode and then scan the barcode on the pouch or

tube label.
The Lot ID and expiration date are entered in the appropriate fields.
NOTE In BD FACSuite™ Clinical application v1.4, add the Lot ID and expiration date manually.

6. Select the Current Lot checkbox.
7. Click OK.

The lot ID and expiration date are added to the appropriate columns for the reagent.
NOTE Make sure to add the reagent lot and expiration date prior to acquisition. This has to be done only
once for a particular reagent lot.

To create a worklist:

1. From the BD FACSuite™ Clinical application navigation bar, click the Worklists icon.
The Worklists workspace opens.

2. In theManage Worklists tab, click New.
A blank worklist opens in a new tab.

3. In theWorklist Entries section, select the appropriate task from the Taskmenu.
4. Enter the Sample ID for BD OneFlow™ reagent tasks.

Do not scan the barcode, found on the tube label, into the software.
NOTE Multiple lots of the same reagent cannot be run on the same worklist.

5. In the Loading Options section, selectManual or Universal Loader from the Loading Optionmenu.
6. If using the Loader, select 30 Tube Rack or 40 Tube Rack from the Carrier Typemenu.

NOTE Confirm that the order of samples in the rack matches the order entered in the software when
setting up the Loader.
See the BD FACSLyric™ System Instructions For Use for more information.

Setting up the Experiment (BD FACSCanto™ II Flow Cytometer)
1. From the menu bar, select Edit > User Preferences, then navigate to the FCS tab, and select Export FCS

after recording, to automatically export the FCS files after acquisition. Click OK.
2. Confirm that the cytometer is in the default 4-2H-2V configuration.
3. From the menu bar, select Experiment > New Experiment > Blank Experiment. Click OK.

NOTE You can also create an experiment directly from the Browser using the Experiment icon.
4. If prompted by the CST Mismatch window, select Use CST Settings.
5. Rename the experiment according to your laboratory practice.
6. In the Browser, right-click Cytometer Settings > Link Setup and select the appropriate compensation

matrix calculated using BD® FC Beads within the past 31 days. Click Link.
See the BD® FC Beads 8-Color Kit for BD OneFlow™ Assays IFU or the Instrument Setup Guide for
BD OneFlow™ Assays.

7. If prompted by the Cytometer Settings Mismatch window, select Overwrite.
8. Right-click Cytometer Settings > Unlink From the previously linked compensation setup. Click OK.

NOTE Unlinking the compensation setup allows updated application settings to be applied while retaining
compensation values.

9. In the Browser, right-click Cytometer Settings > Application Settings > Apply and select the most recent
application settings determined within the last 31 days using the BD OneFlow™ Setup Beads. Click Apply.
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10. A Confirm dialog opens. Select Keep the compensation value.
11. If prompted by the Confirm Cytometer Changes dialog, click Yes to overwrite the cytometer values for

FSC Area Scaling.
12. From the menu bar, select Experiment > New Specimen.

The Panel Templates dialog opens.
13. Navigate to the BD Panels tab and select the OneFlow LST template.
14. Indicate the number of patient specimens you want to acquire using the Copies field near the bottom of

the BD Panels tab. Click OK.
15. Rename each specimen, for example, with the appropriate patient ID in front of the specimen name.

NOTE If you have to re-run a particular patient sample, set the current tube pointer to the tube you wish
to re-run. Click Next Tube in the Acquisition Dashboard to create another tube for that patient. Do not
select Experiment > New Tube from the menu bar or use the New Tube icon from the Browsermenu bar
to create the additional tube to be acquired because the labels and barcode fields will not be populated.
NOTE If you want to acquire additional patient samples stained with the BD OneFlow™ reagent in the
experiment, repeat steps 12–15 to add new specimens.
Two Confirm dialogs will open asking if you want to create another acquisition worksheet or another
analysis worksheet. Click Cancel in each dialog.

16. From the menu bar, select Experiment > Experiment Layout and navigate to the Keywords tab.
17. Highlight the Product ID keyword for the appropriate tube, and scan the barcode on the BD OneFlow™

tube label.
NOTE If you cannot scan the barcode on the tube label, see Troubleshooting.

18. Manually add the appropriate information to the remaining keywords, as needed.
19. Click OK to close the Experiment Layout.

Acquiring the Stained Sample

For BD FACSLyric™ flow cytometers:

Two versions of the assay are available:

Assay version Software Stopping time Acquisition mode

v1.0 BD FACSuite™ Clinical application v1.4 or later 5 minutes Manual

v1.1 BD FACSuite™ Clinical application v1.5 or later 3 minutes Manual, Loader

The assay will automatically collect 100,000 total events. You cannot append the number of events to collect
after acquisition has started. Therefore, if needed, change the number of events to collect before you start
acquisition. To change the number of events to collect, see the BD OneFlow™ Application Guide for Chronic
Lymphoproliferative Diseases for BD FACSLyric™ Flow Cytometers. A clinically relevant number of cells can be
determined at the discretion of an appropriate healthcare professional.

To acquire the sample using the BD OneFlow™ assay v1.1:

1. In theWorklist Controls bar, select Run All from the Runmenu to run the entire worklist from the
beginning.
Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Runmenu.

2. Vortex each stained tube 3–5 seconds at low speed immediately prior to acquisition.
If using the BD FACS™ Universal Loader, vortex tubes immediately before placing them in the Loader racks.
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NOTE Make sure that all of the BD OneFlow™ tubes in the rack are acquired within 1 hour. If not, you
must validate tubes acquired outside the 1 hour time.

3. Follow the prompts in the software to load or unload tubes.
The BD OneFlow™ Acquisition sheet opens. The acquisition sheet contains dot plots and gates to identify
Leukocytes, Lymphocytes, and the relevant cell populations for the assay.

4. Examine each dot plot on the acquisition sheet.
NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.
NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000 total
events, acquisition will stop after 3 minutes. A QC message, “All Events gate does not contain the
requested 100,000 events” is generated in the Lab Report, and can be ignored if the sample can be
analyzed using the events acquired.
See the BD FACSLyric™ System Instructions For Use for more information.

To acquire the sample using the BD OneFlow™ assay v1.0:

1. In theWorklist Controls bar, select Run All from the Runmenu to run the entire worklist from the
beginning.
Alternatively, to acquire a specific tube, set the run pointer to the sample you want to run and select Run
from Pointer from the Runmenu.

2. Vortex each stained tube 3–5 seconds at low speed immediately prior to acquisition.
3. Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ Acquisition sheet opens. The acquisition sheet contains dot plots and gates to identify
Leukocytes, Lymphocytes, and the relevant cell populations for the assay.

4. Examine each dot plot on the acquisition sheet.
NOTE The preview time is 10 seconds and then data is automatically recorded. Do not increase the
preview time and risk loss of the sample due to insufficient volume.

5. If it appears that fewer than 100,000 events will be collected, monitor the sample volume and click Stop
Tube in theWorklist Controls bar to stop acquisition before the tube runs dry.
NOTE The assay will automatically collect 100,000 total events. If the assay cannot collect 100,000 total
events, acquisition will stop after 5 minutes. However, make sure you monitor the sample volume and click
Stop Tube in theWorklist Controls bar to stop acquisition before the tube runs dry. To change the
stopping criteria, see the BD OneFlow™ Application Guide for Chronic Lymphoproliferative Diseases for
BD FACSLyric™ Flow Cytometers.
See the BD FACSLyric™ System Instructions For Use for more information.

For BD FACSCanto™ II flow cytometers:

1. In the Browser, expand the appropriate specimen and set the current tube pointer to that tube.
2. Select the appropriate BD OneFlow™ Acquisition worksheet tab.
3. Vortex the stained tube 3–5 seconds at low speed.
4. Install the tube on the cytometer. Adjust the flow rate toMedium in the Acquisition Dashboard. Click

Acquire Data.
5. Verify that the population is on scale and adjust the gate in the first plot of the acquisition worksheet to

exclude debris, if needed.
6. Click Record Data in the Acquisition Dashboard to collect total events.

NOTE The template will automatically collect 100,000 total events. Use the menu in the Acquisition
Dashboard to select a different number of events to acquire, if needed. A clinically relevant number of cells
can be determined at the discretion of an appropriate healthcare professional.

7. Inspect the dot plots on the acquisition worksheet and adjust the gates as needed.
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Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.
NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The FSC-A vs SSC-A dot plot is used to identify cells.
The remaining dot plots either contain gates to identify the relevant cell populations for the assay, or do
not contain gates and are included to ensure that the antibodies can stain cells in the specimen, therefore
serving as an internal quality control for the tube.
See the appropriate BD OneFlow™ Application Guide for examples of the dot plots showing populations of
normal cells in the acquisition worksheet.

8. Acquire the next sample.
9. From the menu bar, select File > Export > Experiments, and select the Directory Export option. Click OK.

Analyzing the Data Using BD FACSuite™ Clinical Application

NOTE FCS files acquired using BD OneFlow™ assay v1.0 can be opened in BD OneFlow™ assay v1.1.

To analyze a sample stained using BD OneFlow™ LST:
1. Set the run pointer to the appropriate sample in theWorklist Entries panel.

The BD OneFlow™ LST Laboratory Report opens in the Laboratory Report tab.
2. Review the BD OneFlow™ LST Laboratory Report.

The lab report comprises six pages.
– The first page of the report shows sample and tube information, population statistics, and QC
messages, if generated.

Populations with a low number of events might report %Parent or %Grandparent as 0.0%. This is due to
rounding the result to a single decimal place in BD FACSuite™ Clinical application.

– The dot plots on the second page of the lab report are used to exclude debris and doublets and to
identify the major cell populations: leukocytes, lymphocytes, B cells, T cells, TCRγδ+ T cells, and TCRγδ– T
cells.

The gates in the dot plots of the BD OneFlow™ LST Laboratory Report are provided for analyzing
normal and abnormal cell populations in the specimen.
Enlarge the dot plots while adjusting the gates so you can more readily see the populations of interest.
After adjusting the gates, collapse the dot plot to its original size. See the BD OneFlow™ Application
Guide for Chronic Lymphoproliferative Diseases for BD FACSLyric™ Flow Cytometers for examples of dot
plots showing populations of normal cells.

– The dot plots on the third page of the lab report are used to identify the Igκ+ and Igλ+ B cells and to
further characterize the B-cell population.

– The dot plots on the fourth page of the lab report are used to divide the TCRγδ– T cells into CD4+CD8–,
CD8+CD4–, CD4+CD8+, and CD4–CD8– populations. Dot plots are also used to further characterize the
TCRγδ+ and TCRγδ– T cell populations.

– The dot plots on the fifth page of the lab report are used to identify and characterize NK cells.

– The last page of the laboratory report includes lot and expiration dates for BD® CS&T Beads and the
BD OneFlow™ reagent, Characterization QC, reference settings, tube settings, and cytometer configuration.

3. (Optional) Select the Physician Report tab to view the report.
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The OneFlow Physician Report contains a high level summary of the assay results.
4. (Optional) Select the Supplemental Report tab to add additional dot plots to further analyze the sample.

See the BD OneFlow™ Application Guide for Chronic Lymphoproliferative Diseases for BD FACSLyric™ Flow
Cytometers for more information.

Any gated regions deleted in this Supplemental Report are reflected in the Laboratory and Physician Reports.
Any gated regions created in this Supplemental Report might be reflected in the Laboratory Report.

Do not add dot plots or gates to the Laboratory Report or Physician Report. They cannot be deleted and will
invalidate the report.

5. Select the Laboratory Report tab.
6. Click E-Sign.

The E-Signature dialog opens.
7. Select a user ID.
8. Type your password.
9. (Optional) Enter any comments.

10. Click Sign.
The signer’s user ID, date and time, and comments are added to the E-signature box in all three reports.
See the BD FACSLyric™ System Instructions For Use for more information and export options.

To analyze a sample stained using BD OneFlow™ B-CLPD T1:
1. Set the run pointer to the appropriate sample in theWorklist Entries panel.

The BD OneFlow™ B-CLPD T1 Laboratory Report opens in the Laboratory Report tab.
2. Review the BD OneFlow™ B-CLPD T1 Laboratory Report.

The lab report comprises four pages.
– The first page of the report shows sample and tube information, population statistics, and QC
messages, if generated.

Populations with a low number of events might report %Parent or %Grandparent as 0.0%. This is due to
rounding the result to a single decimal place in BD FACSuite™ Clinical application.

– The dot plots on the second page of the lab report are used to exclude debris and doublets and to
identify leukocytes and lymphocytes.

Enlarge the dot plots while adjusting the gates so you can more readily see the populations of interest.
After adjusting the gates, collapse the dot plot to its original size. See the BD OneFlow™ Application
Guide for Chronic Lymphoproliferative Diseases for BD FACSLyric™ Flow Cytometers for examples of dot
plots showing populations of normal cells.

– The dot plots on the third page of the lab report are used to identify and characterize B cells.

– The last page of the lab report shows lot and expiration dates for BD® CS&T Beads and the
BD OneFlow™ reagent, Characterization QC, reference settings, tube settings, and cytometer configuration.

3. (Optional) Select the Physician Report tab to view the report.
The BD OneFlow™ B-CLPD T1 Physician Report contains a high level summary of the assay results.

4. (Optional) Select the Supplemental Report tab to add additional dot plots to further analyze the sample.
See the BD OneFlow™ Application Guide for Chronic Lymphoproliferative Diseases for BD FACSLyric™ Flow
Cytometers for more information.

Any gated regions deleted in this Supplemental Report are reflected in the Laboratory and Physician Reports.
Any gated regions created in this Supplemental Report might be reflected in the Laboratory Report.
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Do not add dot plots or gates to the Laboratory Report or Physician Report. They cannot be deleted and will
invalidate the report.

5. Select the Laboratory Report tab.
6. Click E-Sign.

The E-Signature dialog opens.
7. Select a user ID.
8. Type your password.
9. (Optional) Enter any comments.

10. Click Sign.
The signer’s user ID, date and time, and comments are added to the E-signature box in all three reports.
See the BD FACSLyric™ System Instructions For Use for more information and export options.

Analyzing the Data Using BD FACSDiva™ Software

To analyze a sample stained using BD OneFlow™ LST:
1. From the menu bar, select File > Import > Experiments.
2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis worksheets opens.
3. Select the BD OneFlow™ LST Analysis worksheet tab.
4. Inspect the dot plots on page 1 of the LST analysis worksheet and adjust the gates as needed.

Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.
NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The first three dot plots on the LST analysis worksheet identify cells, FSC singlets, and SSC singlets. Debris
and doublets are excluded by adjusting the gates.
Examine the leukocyte and lymphocyte populations in the CD45 V500-A vs SSC-A dot plot.
Examine the B-cell and T-cell populations in the CD3 APC-A vs CD19+TCRgd PECy7-A dot plot from the
lymphocyte population. Examine the TCRγ/δ+ and TCRγ/δ– populations in the CD3 APC-A vs CD19+TCRgd
PE-Cy7-A dot plot from the T-cell population. The CD38 APC-H7-A vs SSC-A dot plot is included for
informational purposes to allow for the visualization of CD38+ cells.
NOTE See the BD OneFlow™ LST Application Guide for examples of dot plots showing populations of
normal cells.

5. Inspect the dot plots on page 2 of the LST analysis worksheet and adjust the gates as needed.
The dot plots on page 2 of the analysis worksheet identify various populations of T cells. TCRγ/δ– T cells are
divided into
CD8+CD4–, CD4+CD8+, CD4+CD8–, and CD4–CD8– populations in the
CD20+CD4 V450-A vs CD8+IgL FITC-A dot plot.
The remaining dot plots further characterize TCRγ/δ– and TCRγ/δ+ cells using various markers.

6. Inspect the dot plots on page 3 of the LST analysis worksheet and adjust the gates as needed.
The dot plots on page 3 of the analysis worksheet identify B cells. B cells are initially identified as being
CD3–CD19+CD45+. Examine the level of CD20 expression in the CD19+TCRgd PE-Cy7-A vs CD20+CD4
V450-A dot plot.
Examine the ratio of Igκ- to Igλ-expressing B cells in the CD56+IgK PE-A vs CD8+IgL FITC-A dot plot.
The remaining dot plots further characterize B cells using various markers.
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7. Inspect the dot plots on page 4 of the LST analysis worksheet and adjust the gates as needed.
The dot plots on page 4 of the analysis worksheet identify NK cells. NK cells are identified from the NOT(T
cells OR B cells) population in the CD45 V500-A vs CD56+IgK PE-A dot plot.
The remaining dot plots further characterize NK cells using various markers.

8. Examine the results in the statistics box on page 5 of the LST analysis worksheet.
Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see
Troubleshooting.

9. Perform further analyses as needed.
NOTE The gates in the dot plots of the LST analysis worksheet are provided for analyzing normal and
aberrant cell populations in the specimen.

10. Save the LST analysis worksheet as a PDF.
NOTE The analysis worksheet is a global worksheet. Any gates that are adjusted when analyzing a sample
on a global worksheet will be changed in previously analyzed files. Previously saved PDFs won’t change, but
if you go back to a previously analyzed global worksheet, you will have to readjust the gates so they match
what they were before.

11. (Optional) Click Print to print the LST analysis worksheet.
Analyze the next sample.

BD OneFlow™ B-CLPD T1
1. Select the BD OneFlow™ B-CLPD T1 Analysis worksheet tab.
2. Inspect the dot plots on page 1 of the analysis worksheet, and adjust the gates as needed.

Some of the dot plots might look different from those in other experiments. The initial FSC-A vs SSC-A dot
plot to identify cells and eliminate debris may appear compressed. This is a consequence of the target
values used to create the application settings. The values are specified by the EuroFlow Consortium.
NOTE Enlarge the dot plots while adjusting the gates so you can more readily see the populations of
interest. After adjusting the gates, collapse the dot plot to its original size.
The first three dot plots on the analysis worksheet identify cells, FSC singlets, and SSC singlets. Debris and
doublets are excluded by adjusting the gates.
Examine the leukocyte and lymphocyte populations in the CD45 V500-A vs SSC-A dot plot.
NOTE See the BD OneFlow™ Application Guide for B-cell Chronic Lymphoproliferative Diseases for
examples of dot plots showing populations of normal cells in the analysis worksheet.

3. Examine the B-cell population in the CD19 PE-Cy7-A vs CD20 V450-A dot plot on page 2 of the analysis
worksheet and adjust the gate as needed.
The B cells are further characterized according to the levels of CD23, CD10, CD79b, CD200, CD43, and
CD45 expression in the remaining dot plots.

4. Examine the results in the statistics box on page 3 of the analysis worksheet.
Confirm that all of the keywords are present in the statistics box. If any of the keywords are missing, see
Troubleshooting.

5. Perform further analyses as needed.
NOTE The gates in the dot plots of the analysis worksheet are provided for analyzing normal and aberrant
cell populations in the specimen.
NOTE When evaluating a patient sample, you must analyze FCS files acquired from the patient sample
stained with BD OneFlow™ LST as well as with BD OneFlow™ B-CLPD T1.The markers present in
BD OneFlow™ B-CLPD T1 are used in conjunction with CD5, CD38, Anti-Kappa, and Anti-Lambda, present
in BD OneFlow™ LST, to differentially diagnose CLL versus other B-cell chronic lymphoproliferative diseases.
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See the BD OneFlow™ Application Guide for B-cell Chronic Lymphoproliferative Diseases for examples of
dot plots showing populations of normal cells in the analysis worksheet.

6. Save the BD OneFlow™ B-CLPD T1 analysis worksheet as a PDF.
NOTE The BD OneFlow™ B-CLPD T1 analysis worksheet is a global worksheet. Any gates that are adjusted
when analyzing a sample on a global worksheet will changed in previously analyzed files. Previously saved
PDFs won’t change, but if you go back to a previously analyzed global worksheet, you will have to readjust
the gates so they match what they were before.

7. (Optional) Click Print to print the analysis worksheet.
8. Analyze the next sample.

7. RESULTS

Representative Data

See the appropriate application guide to see laboratory reports showing dot plots from a hematologically
normal adult sample stained with each reagent.

For BD FACSLyric™ flow cytometers:

• BD OneFlow™ Application Guide for Chronic Lymphoproliferative Diseases for BD FACSLyric™ Flow
Cytometers

For BD FACSCanto™ II flow cytometers:

• BD OneFlow™ LST Application Guide
• BD OneFlow™ Application Guide for B-cell Chronic Lymphoproliferative Diseases

8. LIMITATIONS
• Use of this reagent for diagnostic evaluation of hematologic disorders should be performed in the context

of a thorough immunophenotypic analysis including other relevant markers.
• Use of the reagents requires experience with leukemia and lymphoma immunophenotyping and

classification. The results should be interpreted by a pathologist, or equivalent professional, in conjunction
with other clinical or laboratory findings.

• The reagents have not been tested on specimens from patients with minimal residual disease (MRD).

9. PERFORMANCE CHARACTERISTICS

Specimen handling and collection (AOB/AOS)

A study was performed to assess the Age of Blood (AOB) and Age of Stain (AOS) using BD OneFlow™ LST and
BD OneFlow™ B-CLPD T1. The stability of EDTA- or heparin-anticoagulated peripheral blood, bone marrow,
and lymph node specimens was evaluated by assessing the combined effect of:

• AOB: Time duration between specimen collection and staining
• AOS: Time duration between completion of stained sample processing and acquisition with the flow

cytometer.
Specimens were tested up to 28 hours post collection and stained samples were tested up to 80 minutes post
stain. All samples were maintained at room temperature before staining or acquisition.

Based on the results of this study, we recommend staining samples within 24 hours of collection and
acquiring samples within 1 hour of staining if the sample is kept at 20–25 °C.
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BD FACSLyric™ Flow Cytometer (BD OneFlow™ LST)

Method comparison, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer (BD OneFlow™
LST)

A method comparison study between the BD OneFlow™ system on the BD FACSLyric™ flow cytometer
(Investigational Method) and the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
(Comparator Method) was performed at 4 clinical sites. The BD OneFlow™ system on BD FACSLyric™
comprises BD® CS&T Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and BD OneFlow™ LST.
Stained samples were acquired on a 10-color BD FACSLyric™ flow cytometer (4-Blue 3-Red 3-Violet) using
BD FACSuite™ Clinical application v1.3* and the BD OneFlow™ LST assay. The BD OneFlow™ reference system
on BD FACSCanto™ II comprises BD FACSDiva™ CS&T IVD Beads, BD OneFlow™ Setup Beads, BD® FC Beads
8-Color Kit for BD OneFlow™ Assays, and BD OneFlow™ LST. Stained samples were acquired on a
BD FACSCanto™ II flow cytometer (4-2H-2V) using BD FACSDiva™ software v8.0.2 and the BD OneFlow™ LST
template. A total of 98 PB specimens, 26 BM specimens, and 16 LN specimens were enrolled in the study.

* A regression study was performed, demonstrating equivalence between BD FACSuite™ Clinical application v1.3 and v1.4.

Specimens were collected in the anticoagulants shown. See the following table.

Specimen type

Anticoagulant

EDTA Heparin

PB 72 26

BM 23 3

Table 4 Anticoagulants used to collect specimens

For PB, BM, and LN specimens, the first wash step was started within 23, 24, or 23 hours of collection,
respectively. Stained PB, BM, and LN samples were acquired within 50, 48, or 31 minutes of final resuspension,
respectively. Samples were identified as being “Abnormal” (abnormal for B cells, T cells, or NK cells) or
“Normal” (normal for T cells, B cells, and NK cells) using the two systems, and compared.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100
Positive % agreement = (a/(a+c))×100
Negative % agreement = (d/(d+b))×100

wherein,

a = number of samples “Abnormal” for both systems,
b = number of samples “Abnormal” on the BD FACSLyric™ flow cytometer but “Normal” on the BD FACSCanto™ II flow
cytometer,
c = number of samples “Normal” on the BD FACSLyric™ flow cytometer but “Abnormal” on the BD FACSCanto™ II flow
cytometer,
d = number of samples “Normal” for both systems.

The results for all cell types are shown in the following table.
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Comparator method
(BD FACSCanto™ II flow cytometer)

Abnormal Normal Total

Investigational method
(BD FACSLyric™ flow cytometer)

Abnormal 63 0 63

Normal 0 77 77

Total 63 77 140

Table 5 Agreement for all cells being “Abnormal” or “Normal”

Overall % agreement is 100%. The lower 95% confidence limit is 97.88%.

The positive agreement for “Abnormal” (abnormal for B cells, T cells, and NK cells) is 100%. The negative
agreement for “Normal” (normal for T cells, B cells, and NK cells) is 100%.

The results for B cells are shown in the following table.

Comparator method
(BD FACSCanto™ II flow cytometer)

Abnormal Normal Total

Investigational method
(BD FACSLyric™ flow cytometer)

Abnormal 52 0 52

Normal 0 88 88

Total 52 88 140

Table 6 Agreement for B cells being “Abnormal” or “Normal”

Overall % agreement is 100%. The lower 95% confidence limit is 97.88%.

The positive agreement for “Abnormal” (abnormal for B cells) is 100%. The negative agreement for “Normal”
(normal for B cells) is 100%.

The results for T cells are shown in the following table.

Comparator method
(BD FACSCanto™ II flow cytometer)

Abnormal Normal Total

Investigational method
(BD FACSLyric™ flow cytometer)

Abnormal 9 0 9

Normal 0 131 131

Total 9 131 140

Table 7 Agreement for T cells being “Abnormal” or “Normal”

Overall % agreement is 100%. The lower 95% confidence limit is 97.88%.

The positive agreement for “Abnormal” (abnormal for T cells) is 100%. The negative agreement for “Normal”
(normal for T cells) is 100%.
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The results for NK cells are shown in the following table.

Comparator method
(BD FACSCanto™ II flow cytometer)

Abnormal Normal Total

Investigational method
(BD FACSLyric™ flow cytometer)

Abnormal 2 0 2

Normal 0 138 138

Total 2 138 140

a. NK cell malignancies are rare, therefore the expected number of samples is very low.

Table 8 Agreement for NK cells being “Abnormal” or “Normal” a

Overall % agreement is 100%. The lower 95% confidence limit is 97.88%.

The positive agreement for “Abnormal” (abnormal for NK cells) is 100%. The negative agreement for
“Normal” (normal for NK cells) is 100%.

Equivalency, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer (BD OneFlow™ LST)

An assessment of the indicated cell populations, expressed as a percentage of another cell population, was
performed for each evaluable specimen enrolled in the method comparison study. Specimens were analyzed
using the BD OneFlow™ system on the BD FACSLyric™ flow cytometer and the BD FACSCanto™ II flow
cytometer as described previously.

The mean bias for the percentages of the indicated cell populations determined on the BD FACSLyric™ flow
cytometer versus the BD FACSCanto™ II flow cytometer was calculated. See the following table.

Population No. of samples Mean bias Lower 95% CL of
mean bias

Upper 95% CL of
mean bias

Leukocytes (%SSC singlets) 134 –0.27 –0.73 0.19

Lymphocytes (%Leukocytes) 134 –0.63 –1.2 –0.06

T cells (%Lymphocytes) 134 –0.17 –0.58 0.24

CD4+CD8– cells (%T cells) 134 –0.53 –1.03 –0.04

CD8+CD4– cells (%T cells) 134 0.2 –0.41 0.81

B cells (%Lymphocytes) 134 –0.26 –0.72 0.19

sIgκ+ cells (%B cells) 134 –1.19 –2.1 –0.29

sIgλ+ cells (%B cells) 134 0.7 0.02 1.38

NK cells (%Lymphocytes) 134 0.45 –0.07 0.98

Table 9 Summary of mean bias for subset percentages

The results of the method comparison and equivalency studies indicate that the two systems are substantially
equivalent.
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Method comparison, BD FACS™ Universal Loader vs manual acquisition (BD OneFlow™ LST)

A study was performed at one site to demonstrate equivalency between acquisition using the BD FACS™
Universal Loader and manual acquisition. Peripheral blood or bone marrow specimens from normal and
abnormal subjects were stained using 1 lot of BD OneFlow™ LST. For each specimen, 10 stained replicates
were acquired either manually or using the BD FACS™ Universal Loader (using the 30-tube and 40-tube racks).

The mean, absolute bias, and relative bias for acquisition using the BD FACS™ Universal Loader vs manual
acquisition were determined for the indicated populations. See the following table.

Population N

Mean

Absolute % bias (95% CI) Relative % bias (95% CI)Loader Manual

Leukocytes (%SSC singlets) 17 95.46 94.83 0.64 (0.07, 1.21) 0.7 (0.1, 1.3)

Lymphocytes (%Leukocytes) 17 29.79 29.52 0.27 (–0.14, 0.68) 0.9 (–1.4, 3.2)

B cells (%Lymphocytes) 17 20.39 20.48 –0.09 (–0.40, 0.22) –0.8 (–6.0, 4.6)

sIgκ+ cells (%B cells) 16 61.27 62.89 –0.47 (–1.79, 0.86) 0.6 (–3.8, 5.3)

sIgλ+ cells (%B cells) 16 38.4 36.63 0.60 (–0.60, 1.79) 1.5 (–1.5, 4.6)

T cells (%Lymphocytes) 17 68.08 68.2 –0.12 (–0.65, 0.42) 0.6 (–0.7, 1.8)

TCRγδ+ cells (%Lymphocytes) 17 4.34 4.4 –0.06 (–0.28, 0.16) 0.9 (–6.4, 8.7)

CD4+CD8– (%T cells) 17 45.99 45.95 0.05 (–0.46, 0.55) 0.2 (–1.1, 1.7)

CD8+CD4– (%T cells) 17 44.61 44.31 0.30 (–0.21, 0.81) 0.9 (–0.5, 2.2)

NK cells (%Lymphocytes) 17 9.86 10.08 –0.22 (–0.73, 0.29) –3.0 (–9.4, 3.9)

Table 10 BD FACS™ Universal Loader vs manual acquisition for BD OneFlow™ LST

The results were also assessed qualitatively by a hematopathologist for concordance between samples
acquired manually and samples acquired using the Loader. All samples stained with BD OneFlow™ LST
showed 100% agreement.

Precision (within-site, control material) (BD OneFlow™ LST on BD FACSLyric™)

A 21-day single-site precision study was performed to assess the within-site precision (repeatability and
reproducibility) of BD OneFlow™ LST using control material. Estimates of precision were determined across
three BD FACSLyric™ flow cytometers and a minimum of three operators by acquiring BD Multi-Check™
Control, stained in duplicate by each operator using three lots of BD OneFlow™ LST. Two separate runs were
performed by each operator on each of the 21 tested days.

Twelve cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, between operators, between lots,
and between instruments) were estimated. A total of 756 samples were analyzed. The mean, standard
deviation (SD), and coefficient of variation (%CV) is presented for each population. In addition, the one-sided
95% confidence limit (Upper SD or Upper %CV) for the within-site precision was calculated.
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Population (% of positive) Mean

Repeatability Reproducibility Within-site precision

SD %CV SD %CV Upper SD Upper %CV

CD19+ 13.51 0.26 1.90 0.22 0.02 0.38 2.82

CD3+ 74.03 0.29 0.39 0.40 0.01 0.90 1.21

CD20+ 98.45 0.20 0.20 0.35 0.00 0.75 0.77

CD45+ 100.00 0.00 0.00 0.00 0.00 0.00 0.00

Igκ+ 62.42 0.82 1.32 0.89 0.01 1.69 2.70

Igλ+ 37.41 0.83 2.21 0.90 0.02 1.73 4.62

TCRγ/δ+ 2.94 0.11 3.70 0.11 0.04 0.20 6.67

CD56+ 98.42 0.23 0.23 0.17 0.00 0.34 0.35

CD4+ 69.95 0.31 0.44 0.16 0.00 0.41 0.59

CD5+ 74.33 0.28 0.38 0.61 0.01 1.64 2.21

CD8+ 27.10 0.30 1.11 0.49 0.02 1.37 5.07

CD38+ 47.53 0.64 1.34 5.34 0.11 6.26 13.17

Table 11 Summary of within-site precision of subset percentages for BD OneFlow™ LST

Precision (reproducibility, control material) (BD OneFlow™ LST on BD FACSLyric™)

A study was performed at three sites to assess the reproducibility of the system. One lot of BD OneFlow™ LST
was used to stain three replicates of BD Multi-Check™ Control. Two runs per day were acquired on a
BD FACSLyric™ flow cytometer by one operator per site over a period of 5 days.

Twelve cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, and between sites) were
estimated. The mean, standard deviation (SD), and coefficient of variation (%CV) is presented for each
population. A total of 90 samples were analyzed. In addition, the one-sided 95% confidence limit (Upper SD
or Upper %CV) for the overall precision was calculated.

Population (% of positive) Mean

Repeatability Reproducibility Overall precision

SD %CV SD %CV Upper SD Upper %CV

CD19+ 13.85 0.24 1.76 0.07 0.00 0.29 2.08

CD3+ 73.57 0.31 0.42 0.48 0.01 1.32 1.80

CD20+ 99.12 0.14 0.14 0.13 0.00 0.24 0.25

CD45+ 35.59 0.37 1.04 0.64 0.02 1.27 3.56

Igκ+ 57.98 0.75 1.29 0.65 0.01 1.17 2.01

Igλ+ 41.65 0.83 1.99 0.85 0.02 1.41 3.38

Table 12 Summary of multi-site precision of subset percentages for BD OneFlow™ LST
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Population (% of positive) Mean

Repeatability Reproducibility Overall precision

SD %CV SD %CV Upper SD Upper %CV

TCRγ/δ+ 96.10 0.16 0.17 0.19 0.00 0.39 0.40

CD56+ 98.51 0.31 0.31 0.28 0.00 0.69 0.70

CD4+ 66.21 0.28 0.42 0.21 0.00 0.41 0.62

CD5+ 73.89 0.39 0.52 0.51 0.01 1.24 1.67

CD8+ 30.76 0.34 1.09 0.31 0.01 0.75 2.45

CD38+ 92.27 0.32 0.35 0.20 0.00 0.47 0.51

Detection capability (BD OneFlow™ LST)

The detection capability of BD OneFlow™ LST was assessed. An abnormal specimen was added to a
hematologically normal peripheral blood specimen such that the abnormal population was at 0%, 0.02%,
0.05%, or 0.1% of all events of the normal specimen. Two sets of abnormal and normal specimens and 2 lots
of BD OneFlow™ LST were evaluated in the study.

Sample
Target

population

Expected
% abnormal

cells

Mean actual %
abnormal cell

(95% CI)
SD of bias

(Upper 95% CI) Ratioa

1 CD45dim

CD19+

CD20dim

Igκ+

CD5+

0.0 0.003
(0.004, 0.002)

0.001
(0.003)

0/0

0.02 0.026
(0.030, 0.022)

0.005
(0.01)

10/10

0.05 0.061
(0.067, 0.056)

0.008
(0.014)

10/10

0.1 0.118
(0.130, 0.105)

0.017
(0.032)

10/10

2 CD45dim

CD19+

CD20dim

Igκ+

CD5+

0.0 0.00
(0.001, 0.000)

0.000
(0.001)

0/0

0.02 0.018
(0.022, 0.014)

0.006
(0.01)

10/10

0.05 0.043
(0.048, 0.037)

0.008
(0.014)

10/10

0.1 0.111
(0.122, 0.100)

0.015
(0.028)

10/10

a. Expected/actual number of positive replicates.

Table 13 Detection capability of BD OneFlow™ LST

Based on the results, a detection capability of 0.03% of all events is recommended for BD OneFlow™ LST.
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BD FACSLyric™ Flow Cytometer (BD OneFlow™ B-CLPD T1)

Method comparison, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer (BD OneFlow™ B-
CLPD T1)

A method comparison study between the BD OneFlow™ system on the BD FACSLyric™ flow cytometer
(Investigational Method) and the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
(Comparator Method) was performed at 4 external clinical sites. The BD OneFlow™ system on BD FACSLyric™
comprises BD® CS&T Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, BD OneFlow™ LST, and
BD OneFlow™ B-CLPD T1. Stained samples were acquired on a 10-color BD FACSLyric™ flow cytometer (4-Blue
3-Red 3-Violet) using BD FACSuite™ Clinical application v1.3† and the BD OneFlow™ B-CLPD T1 assay. The
BD OneFlow™ reference system on BD FACSCanto™ II comprises BD FACSDiva™ CS&T IVD Beads,
BD OneFlow™ Setup Beads, BD® FC Beads 8-Color Kit for BD OneFlow™ Assays, and BD OneFlow™ B-CLPD T1.
Stained samples were acquired on a BD FACSCanto™ II flow cytometer (4-2H-2V) using BD FACSDiva™
software v8.0.2 and the BD OneFlow™ B-CLPD T1 template. A total of 93 evaluable PB specimens, 26
evaluable BM specimens, and 16 evaluable LN specimens were enrolled in the study.

† A regression study was performed, demonstrating equivalence between BD FACSuite™ Clinical application v1.3 and v1.4.

Specimens were collected in the anticoagulants shown. See the following table.

Specimen type

Anticoagulant

EDTA Heparin

PB 68 25

BM 23 3

Table 14 Anticoagulants used to collect specimens

For PB, BM, and LN specimens, the first wash step was started within 23, 24, or 23 hours of collection,
respectively. Stained PB, BM, and LN samples were acquired within 58, 49, or 34 minutes of final resuspension,
respectively. Samples with aberrant B cell populations were identified as “CLL” or “Other B-CLPD” (including
presumptive cases of atypical CLL) using the two systems. Samples were analyzed as “CLL” or “Non-

CLL” using the two systems, and compared. “Non-CLL” includes “Other B-CLPD”, abnormal T, abnormal NK,
and “normal” (normal for T cells, B cells, and NK cells). Furthermore, samples were analyzed as “Other B-CLPD”
or Non-Other B-CLPD” using the two systems, and compared. “Non-Other B-CLPD” includes CLL, abnormal T,
abnormal NK, and “normal” (normal for T cells, B cells, and NK cells).

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100
Positive % agreement = (a/(a+c))×100
Negative % agreement = (d/(d+b))×100

wherein,

a = number of samples identified as “CLL” for both systems,
b = number of samples identified as “CLL” on the BD FACSLyric™ flow cytometer but identified as “Non-CLL” on the
BD FACSCanto™ II flow cytometer,
c = number of samples identified as “Non-CLL” on the BD FACSLyric™ flow cytometer but identified as “CLL” on the
BD FACSCanto™ II flow cytometer,
d = number of samples identified as “Non-CLL” for both systems.
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The results for specimens identified as “CLL” or “Non-CLL” were tabulated. See the following table.

Comparator method
(BD FACSCanto™ II flow

cytometer)

CLL Non-CLL Total

Investigational method
(BD FACSLyric™ flow
cytometer)

CLL 25 0 25

Non-CLL 0 110 110

Total 25 110 135

Table 15 Agreement for specimens identified as “CLL” or “Non-CLL”

Overall % agreement is 100%. The lower 95% confidence limit is 97.81%.

The positive agreement for “CLL” is 100%. The negative agreement for “Non-CLL” is 100%.

Agreement was also calculated using the formulas described previously wherein,

a = number of samples identified as “Other B-CLPD” for both systems,
b = number of samples identified as “Other B-CLPD” on the BD FACSLyric™ flow cytometer but identified as “Non-Other B-
CLPD” on the BD FACSCanto™ II flow cytometer,
c = number of samples identified as “Non-Other B-CLPD” on the BD FACSLyric™ flow cytometer but identified as “Other B-
CLPD” on the BD FACSCanto™ II flow cytometer,
d = number of samples identified as “Non-Other B-CLPD” for both systems.

The results for specimens identified as “Other B-CLPD” or “Non-Other B-CLPD” were tabulated. See the
following table.

Comparator method
(BD FACSCanto™ II flow

cytometer)

Other B-CLPD Non-Other
B-CLPD

Total

Investigational method
(BD FACSLyric™ flow
cytometer)

Other B-CLPD 27 0 27

Non-Other
B-CLPD

0 108 108

Total 27 108 135

Table 16 Agreement for specimens identified as “Other B-CLPD” or “Non-Other B-CLPD”

Overall % agreement is 100%. The lower 95% confidence limit is 97.81%.

The positive agreement for “Other B-CLPD” is 100%. The negative agreement for “Non-Other B-CLPD” is
100%.
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Equivalency, BD FACSLyric™ vs BD FACSCanto™ II flow cytometer (BD OneFlow™ B-CLPD
T1)

A qualitative assessment of the relative fluorescence intensity, either positive or negative, of the indicated
markers in aberrant B cells was performed for each evaluable specimen enrolled in the method comparison
study. Specimens were analyzed using the BD OneFlow™ system on the BD FACSLyric™ flow cytometer and
the BD FACSCanto™ II flow cytometer as described previously. Overall agreement of the two systems in
assessing the expression, either positive or negative, of the indicated markers in the specimens was
calculated. See the following table.

Marker BD OneFlow™ reagent
tube

% Agreement for the
expression of marker

Lower 95% CL of %
agreement

CD5 LST 98.08 91.20

CD20 LST 100.0 94.4

CD20 B-CLPD T1 100.0 94.4

CD200 B-CLPD T1 100.0 94.4

CD23 B-CLPD T1 100.0 94.4

CD79b B-CLPD T1 100.0 94.4

CD10 B-CLPD T1 100.0 94.4

CD43 B-CLPD T1 96.15 88.38

Table 17 Agreement for qualitative marker expression on BD FACSLyric™ and BD FACSCanto™ II flow
cytometers

The results of the method comparison and equivalency studies indicate that the two systems are substantially
equivalent.

Method comparison, BD FACS™ Universal Loader vs manual acquisition (BD OneFlow™ B-
CLPD T1)

A study was performed at one site to demonstrate equivalency between acquisition using the BD FACS™
Universal Loader and manual acquisition. Peripheral blood or bone marrow specimens from normal and
abnormal subjects were stained using 1 lot of BD OneFlow™ B-CLPD T1. For each specimen, 10 stained
replicates were acquired either manually or using the BD FACS™ Universal Loader (using the 30-tube and 40-
tube racks).

The mean, absolute bias, and relative bias for acquisition using the BD FACS™ Universal Loader vs manual
acquisition were determined for the indicated populations. See the following table.

Population N

Mean

Absolute % bias (95% CI) Relative % bias (95% CI)Loader Manual

Leukocytes (%SSC singlets) 17 93.56 92.89 0.67 (0.12, 1.22) 0.8 (0.2, 1.4)

Lymphocytes (%Leukocytes) 17 27.84 27.84 0.00 (–0.71, 0.71) 0.2 (–2.3, 2.7)

B cells (%Lymphocytes) 17 19.97 20.04 –0.06 (–0.46, 0.33) 0.4 (–2.6, 3.6)

Table 18 BD FACS™ Universal Loader vs manual acquisition for BD OneFlow™ B-CLPD T1
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The results were also assessed qualitatively by a hematopathologist for concordance between samples
acquired manually and samples acquired using the Loader. All samples stained with BD OneFlow™ B-CLPD T1
showed 100% agreement.

Precision (within-site, control material) (BD OneFlow™ B-CLPD T1 on BD FACSLyric™)

A 21-day single-site precision study was performed to assess the within-site precision (repeatability and
reproducibility) of BD OneFlow™ B-CLPD T1 using control material. Estimates of precision were determined
across three BD FACSLyric™ flow cytometers and a minimum of three operators by acquiring CD-Chex Plus®

control, stained in duplicate by each operator using three lots of BD OneFlow™ B-CLPD T1. Two separate runs
were performed by each operator on each of the 21 tested days.

Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, between operators, between lots,
and between instruments) were estimated. A total of 756 samples were analyzed. The mean, standard
deviation (SD), and coefficient of variation (%CV) is presented for each population. In addition, the one-sided
95% confidence limit (Upper SD or Upper %CV) for the within-site precision was calculated.

Population (% of positive) Mean

Repeatability Reproducibility Within-site precision

SD %CV SD %CV Upper SD Upper %CV

CD43+ 85.73 0.20 0.24 0.23 0.00 0.43 0.51

CD45+ 42.16 1.15 2.72 0.53 0.01 1.34 3.19

CD10+ 97.87 0.22 0.23 0.34 0.00 0.72 0.73

CD79b+ 13.45 0.19 1.44 0.46 0.03 1.31 9.77

CD19+ 13.91 0.19 1.39 0.08 0.01 0.23 1.63

CD20+ 13.68 0.19 1.41 0.27 0.02 0.62 4.55

CD200+ 11.00 0.17 1.56 0.25 0.02 0.54 4.92

CD23+ 12.91 0.19 1.51 0.61 0.05 1.92 14.85

Table 19 Summary of with-site precision of subset percentages for BD OneFlow™ B-CLPD T1

Precision (reproducibility, control material) (BD OneFlow™ B-CLPD T1 on BD FACSLyric™)

A study was performed at three sites to assess the reproducibility of the system. One lot of BD OneFlow™
BCLPD T1 was used to stain three replicates of CD-Chex Plus® control. Two runs per day were acquired on a
BD FACSLyric™ flow cytometer by one operator per site over a period of 5 days.

Eight cell populations were identified as being a percentage of the parent population. Repeatability (within-
run variability) and reproducibility (variability between runs, between days, and between sites) were
estimated. A total of 90 samples were analyzed.The mean, standard deviation (SD), and coefficient of
variation (%CV) is presented for each population. In addition, the one-sided 95% confidence limit (Upper SD
or Upper %CV) for the overall precision was calculated.
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Population (% of positive) Mean

Repeatability Reproducibility Overall precision

SD %CV SD %CV Upper SD Upper %CV

CD43+ 86.20 0.20 0.23 0.29 0.00 0.80 0.92

CD45+ 39.06 0.43 1.10 0.73 0.02 1.11 2.84

CD10+ 97.89 0.71 0.73 0.63 0.01 1.50 1.53

CD79b+ 13.10 0.21 1.63 0.21 0.02 0.49 3.75

CD19+ 13.26 0.21 1.56 0.16 0.01 0.39 2.96

CD20+ 13.15 0.21 1.59 0.19 0.01 0.46 3.52

CD200+ 10.24 0.18 1.75 0.28 0.03 0.75 7.36

CD23+ 12.92 0.21 1.65 0.13 0.01 0.32 2.50

Table 20 Summary of multi-site precision of subset percentages for BD OneFlow™ B-CLPD T1

Detection capability (BD OneFlow™ B-CLPD T1)

The detection capability of BD OneFlow™ B-CLPD T1 was assessed. An abnormal specimen was added to a
hematologically normal peripheral blood specimen such that the abnormal population was at 0%, 0.02%,
0.05%, or 0.1% of all events of the normal specimen. Two sets of abnormal and normal specimens and 2 lots
of BD OneFlow™ BCLPD T1 were evaluated in the study.

Sample
Target

population

Expected
% abnormal

cells

Mean actual %
abnormal cell

(95% CI)
SD of bias

(Upper 95% CI) Ratioa

1 CD45dim

CD19+

CD20dim

CD43+
CD200+

0.0 0
(0.000, 0.000)

0
(0.001)

0/0

0.02 0.027
(0.031, 0.022)

0.006
(0.011)

10/10

0.05 0.054
(0.061, 0.046)

0.010
(0.019)

10/10

0.1 0.111
(0.123, 0.099)

0.016
(0.030)

10/10

2 CD45dim

CD19+

CD20dim

CD43+
CD200+

0.0 0
(0.001, 0.000)

0
(0.001)

0/0

0.02 0.02
(0.023, 0.018)

0.003
(0.006)

10/10

0.05 0.053
(0.058, 0.048)

0.007
(0.012)

10/10

0.1 0.102
(0.110, 0.093)

0.012
(0.022)

10/10

a. Expected/actual number of positive replicates.

Table 21 Detection capability of BD OneFlow™ B-CLPD T1
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Based on the results, a detection capability of 0.03% of all events is recommended for BD OneFlow™ B-CLPD
T1.

BD FACSCanto™ II Flow Cytometer (BD OneFlow™ LST)

Method comparison, BD FACSCanto™ II flow cytometer vs EuroFlow system
(BD OneFlow™LST)

A side-by-side comparison study between the BD OneFlow™ LST system on the BD FACSCanto™ II flow
cytometer and the EuroFlow LST system on the BD FACSCanto™ II flow cytometer was performed at 3
external clinical sites. The BD OneFlow™ LST system comprises BD OneFlow™ Setup Beads, BD® FC Beads for
compensation, and the BD OneFlow™ LST reagent. The EuroFlow LST reference system comprises Sphero™
Rainbow calibration particles (8 peaks), single color stained cells plus BD® Multicolor CompBeads for
compensation, and the EuroFlow LST reagent cocktail. Both methods used BD FACSDiva™ CS&T IVD beads to
perform instrument quality control. Abnormal mature lymphocyte populations from 81 patients with B-cell
malignancies, 35 patients with T-cell malignancies, and 6 patients with NK-cell malignancies were identified
using the two systems, and compared. In addition, 9 samples were identified as being from other lineages, for
example, plasma cell disorders or bi-phenotypic samples. Cell populations from 76 negative samples, including
19 healthy donors, were identified using the two systems. A total of 123 PB specimens, 53 BM specimens, and
31 fresh LN specimens were enrolled in the study. PB and BM specimens were stained within 24 hours of
collection. LN specimens were stained within 6 hours of collection. All stained samples were acquired within 1
hour of staining. Samples were identified as being “Follow-up needed” or “No follow-up needed” using the two
systems, and compared.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,

a = number of samples “Follow-up needed” for both systems,
b = number of samples “Follow-up needed” for the BD OneFlow™ system but “No follow-up needed” for the EuroFlow
system,
c = number of samples “No follow-up needed” for the BD OneFlow™ system but “Follow-up needed” for the Euroflow
system, and
d = number of samples “No follow-up needed” for both systems.

The results for all cell types are shown in the following table.

Comparator method
(Euroflow LST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ LST)

Follow-up
needed

131 0 131

No follow-up
needed

0 76 76

Total 131 76 207

Table 22 Agreement for all cells being “Follow-up needed” or “No follow-up needed”
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Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.

The results for T cells are shown in the following table.

Comparator method
(Euroflow LST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ LST)

Follow-up
needed

35 0 35

No follow-up
needed

0 172 172

Total 35 172 207

Table 23 Agreement for T cells being “Follow-up needed” or “No follow-up needed”

Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.

The results for B cells are shown in the following table.

Comparator method
(Euroflow LST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ LST)

Follow-up
needed

81 0 81

No follow-up
needed

0 126 126

Total 81 126 207

Table 24 Agreement for B cells being “Follow-up needed” or “No follow-up needed”

Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.

The results for NK cells are shown in the following table.

Comparator method
(Euroflow LST cocktail)

Follow-up
needed

No follow-up
needed

Total

Investigational method
(BD OneFlow™ LST)

Follow-up
needed

6 0 6

No follow-up
needed

0 201 201

Table 25 Agreement for NK cells being “Follow-up needed” or “No follow-up needed”a
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Comparator method
(Euroflow LST cocktail)

Total 6 201 207

a. NK cell malignancies are rare, therefore the expected number of samples is very low.

Overall % agreement is 100%. The lower 95% confidence limit is 98.6%.

Equivalency, BD FACSCanto™ II flow cytometer vs EuroFlow system (BD OneFlow™ LST)

Peripheral blood, bone marrow, and lymph node specimens collected at 3 external clinical laboratories were
obtained from patients with T-cell, B-cell, or NK-cell abnormalities, or with no hematological abnormalities.
Specimens were analyzed using the BD OneFlow™ LST system and the EuroFlow LST system described
previously.

The bias for leukocytes identified as being a percentage of SSC singlets is summarized in the following table.

Population No. of samples Average bias Lower 95% CL of average bias Upper 95% CL of average bias

Leukocytes
(%SSC singlets)

207 –1.1% –1.7% –0.6%

Table 26 Summary of bias for Leukocytes (%SSC singlets)

The remaining eight cell populations were identified as being a percentage of the cell populations indicated in
the following table. Deming regression statistics indicate that the results obtained using the two systems are
substantially equivalent.

Population No. of samples Intercept Slope Lower 95% CL of
average bias

Upper 95% CL of
average bias

Lymphocytes
(%Leukocytes)

207 –0.68 1.01 1.00 1.02

T cells
(%Lymphocytes)

207 1.07 0.99 0.98 1.00

CD4+CD8– cells
(%T cells)

207 –0.64 1.01 1.00 1.02

CD8+CD4– cells
(%T cells)

207 –0.45 1.00 0.99 1.01

B cells
(%Lymphocytes)

207 –0.01 1.00 0.99 1.00

NK cells
(%Lymphocytes)

207 0.81 0.92 0.84 1.00

smIgκ+ cells
(%B cells)

206a 2.24 1.00 0.97 1.02

Table 27 Equivalency of the BD OneFlow™ system to the EuroFlow system
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Population No. of samples Intercept Slope Lower 95% CL of
average bias

Upper 95% CL of
average bias

smIgλ+ cells
(%B cells)

206a –2.04 1.00 0.98 1.03

a. One patient specimen had 0 and 2 B-cell events for the two systems, respectively. Since smIgκ and smIgλ are defined as a percentage of B-cell events in this study, they could not
be defined in one system, and therefore could not be included in the analysis for smIgκ and smIgλ for that specimen.

Precision (reproducibility) (BD OneFlow™ LST on BD FACSCanto™ II)

Two operators performed two separate runs per day over a period of 8 days, alternating the runs on two
BD FACSCanto™ II flow cytometers. For each run, duplicate samples of BD Multi-Check™ Control were stained
using three lots of BD OneFlow™ LST by each operator, and then acquired and analyzed using the
BD OneFlow™ LST template in BD FACSDiva™ software. Nine cell populations were identified as being a
percentage of the cell populations indicated in the following table. The reproducibility of the subset
percentages was calculated for each cell population. Reproducibility comprises four components:
operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and day-to-day reproducibility.

Population Mean SDa Upper 95% CLb of SD %CVc Upper 95% CL of %CV

Leukocytes (%SSC Singlets) 100.0 0.01 0.03 0.01 0.03

Lymphocytes (%Leukocytes) 37.9 0.5 1.1 1.2 2.9

T cells (%Lymphocytes) 70.3 0.2 0.3 0.3 0.5

CD4+CD8– cells (%T cells) 63.4 0.5 1.5 0.8 2.4

CD8+CD4– cells (%T cells) 25.1 1.1 3.2 4.4 12.8

B cells (%Lymphocytes) 14.8 0.2 1.0 1.5 6.5

NK cells (%Lymphocytes) 14.8 0.3 0.8 1.9 5.6

smIgκ+ cells (%B cells) 59.4 0.2 3.1 0.3 5.2

smIgλ+ cells (%B cells) 40.6 0.2 2.8 0.4 6.8

a. SD = Standard deviation

b. CL = Confidence limit

c. %CV = Coefficient of variation

Table 28 Reproducibility of subset percentages

Precision (repeatability) (BD OneFlow™ LST on BD FACSCanto™ II)

Two operators performed two separate runs per day over a period of 8 days, alternating the runs on two
BD FACSCanto™ II flow cytometers. For each run, duplicate samples of BD Multi-Check™ Control were stained
using three lots of BD OneFlow™ LST by each operator, and then acquired and analyzed using the
BD OneFlow™ LST template in BD FACSDiva™ software. Nine cell populations were identified as being a
percentage of the cell populations indicated in the following table. The within-run precision (tube-to-tube
repeatability) of the subset percentages was calculated for each of the cell populations.
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Population Mean SD Upper 95% CL of SD %CV Upper 95% CL of %CV

Leukocytes (%SSC Singlets) 100.0 0.03 0.03 0.03 0.03

Lymphocytes (%Leukocytes) 37.9 0.5 0.5 1.3 1.4

T cells (%Lymphocytes) 70.3 0.4 0.4 0.5 0.6

CD4+CD8– cells (%T cells) 63.4 0.5 0.6 0.8 0.9

CD8+CD4– cells (%T cells) 25.1 0.7 0.8 3.0 3.2

B cells (%Lymphocytes) 14.8 0.3 0.3 1.8 2.0

NK cells (%Lymphocytes) 14.8 0.3 0.3 2.1 2.3

smIgκ+ cells (%B cells) 59.4 0.8 0.8 1.3 1.4

smIgλ+ cells (%B cells) 40.6 0.8 0.8 1.9 2.1

Table 29 Repeatability of subset percentages

BD FACSCanto™ II Flow Cytometer (BD OneFlow™ B-CLPD T1)

Method comparison, BD FACSCanto™ II flow cytometer vs EuroFlow system (BD OneFlow™
B-CLPD T1)

A side-by-side comparison study between the BD OneFlow™ system on the BD FACSCanto™ II flow cytometer
and the EuroFlow system on the BD FACSCanto™ II flow cytometer was performed at 4 external clinical sites.
The BD OneFlow™ system comprises BD OneFlow™ Setup Beads, BD® FC Beads for compensation, the
BD OneFlow™ LST reagent, and the BD OneFlow™ B-CLPD T1 reagent. The EuroFlow reference system
comprises Sphero™ Rainbow calibration particles (8 peaks), single color stained cells plus BD® CompBead
particles for compensation, and the corresponding EuroFlow reagent cocktails. Both methods used BD
FACSDiva™ CS&T IVD beads to perform instrument quality control. Abnormal mature B-cell populations from
54 patients with CLL and 47 patients with other B-cell disorders, including presumptive cases of atypical CLL,
were identified using the two systems, and compared. A total of 70 PB specimens and 31 BM specimens were
enrolled in the study. PB and BM specimens were stained within 26 hours of collection. All stained samples
were acquired within 66 minutes of staining. Samples with B cells needing follow-up were classified as CLL or
another B-cell disorder.

Agreement was calculated as follows:

Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,

a = number of samples classified as CLL for both systems,
b = number of samples classified as CLL for the BD OneFlow™ system but classified as other B-cell disorder for the
EuroFlow system,
c = number of samples classified as other B-cell disorder for the BD OneFlow™ system but classified as CLL for the
Euroflow system, and
d = number of samples classified as other B-cell disorder for both systems.

The results for samples classified as CLL or another B-cell disorder were tabulated. See the following table.
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Comparator method
(Euroflow LST cocktail)

CLL Other B-cell
disorder

Total

Investigational method
(BD OneFlow™ system)

CLL 54 0 54

Other B-cell
disorder

0 47 47

Total 54 47 101

Table 30 Agreement for B cells needing follow-up as CLL or other B-cell disorder

Overall % agreement is 100%. The lower 95% confidence limit is 97.1%.

Equivalency, BD FACSCanto™ II flow cytometer vs EuroFlow system (BD OneFlow™ B-CLPD
T1)

Specimens with CD45+CD19+ B cells identified as needing follow-up using the BD OneFlow™ LST tube were
further characterized according to the expression of specific markers. Specimens were analyzed using the
BD OneFlow™ system and the corresponding EuroFlow system described previously. Agreement of the two
systems in assessing the expression, either positive or negative, of the indicated markers in aberrant B cells
was calculated. See the following table.

Marker BD OneFlow™ reagent
tube

% Agreement for the
expression of marker

Lower 95% CL of %
agreement

CD5 LST 98.0% 93.9%

CD20 LST 100.0% 97.1%

CD20 B-CLPD T1 100.0% 97.1%

CD200 B-CLPD T1 100.0% 97.1%

CD23 B-CLPD T1 100.0% 97.1%

CD79b B-CLPD T1 99.0% 95.4%

Table 31 Equivalency of the BD OneFlow™ system to the EuroFlow system

The results of the method comparison and equivalency studies indicate that the two systems are substantially
equivalent.

Precision (reproducibility) (BD OneFlow™ B-CLPD T1 on BD FACSCanto™ II)

Two operators performed two separate runs per day over a period of 8 days, alternating the runs on two
BD FACSCanto™ II flow cytometers. For each run, duplicate samples of CD-Chex Plus® BC were stained using
three lots of BD OneFlow™ B-CLPD T1 by each operator, and then acquired and analyzed using the
BD OneFlow™ B-CLPD T1 template in BD FACSDiva™ software. Three cell populations were identified as being
a percentage of the cell populations indicated in Table 32. The reproducibility of the subset percentages was
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calculated for each cell population. Reproducibility comprises four components: operator/instrument-to-
operator/instrument, lot-to-lot, run-to-run, and day-to-day reproducibility.

Population Mean SDa Upper 95% CLb of SD %CVc Upper 95% CL of %CV

Leukocytes (%SSC Singlets) 100.00 0.00 0.00 0.00 0.00

Lymphocytes (%Leukocytes) 36.94 1.23 1.40 3.34 3.74

B cells (%Lymphocytes) 12.45 0.19 0.22 1.53 1.71

a. SD = Standard deviation

b. CL = Confidence limit

c. %CV = % Coefficient of variation

Table 32 Reproducibility of subset percentages

Precision (repeatability) (BD OneFlow™ B-CLPD T1 on BD FACSCanto™ II)

Two operators performed two separate runs per day over a period of 8 days, alternating the runs on two
BD FACSCanto™ II flow cytometers. For each run, duplicate samples of CD-Chex Plus BC were stained using
three lots of BD OneFlow™ B-CLPD T1 by each operator, and then acquired and analyzed using the
BD OneFlow™ B-CLPD T1 template in BD FACSDiva™ software. Three cell populations were identified as being
a percentage of the cell populations indicated in the following table. The within-run precision (tube-to-tube
repeatability) of the subset percentages was calculated for each cell population.

Population Mean SD Upper 95% CL of SD %CV Upper 95% CL of %CV

Leukocytes (%SSC Singlets) 100.00 0.00 0.00 0.00 0.00

Lymphocytes (%Leukocytes) 36.94 0.40 0.45 1.08 1.21

B cells (%Lymphocytes) 12.45 0.19 0.22 1.52 1.70

Table 33 Repeatability of subset percentages

10. TROUBLESHOOTING

Problems with cell preparation or staining

Problem Possible cause Solution

The resolution between debris and
lymphocytes is poor.

Specimen was poorly lysed. Prepare and stain another specimen.

Specimen is of poor quality. Check cell viability.

Specimen is too old. Obtain a new specimen and stain it
immediately.

Staining is dim or fading. Cell concentration was too high at the
staining step.

Check the cell concentration and
adjust as needed.

Washed specimen was not stained
within 30 minutes of the last wash.

Repeat staining with a freshly
prepared specimen.
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Problem Possible cause Solution

The reagent tube was exposed to
light for too long.

Repeat staining with a new tube of
reagent.

Stained cells were stored too long
before acquiring them.

Repeat staining with a fresh specimen
and acquire it promptly.

Few or no cells are recorded. Cell concentration was too low. Centrifuge specimen and resuspend it
at a higher concentration. Repeat
staining and acquisition.

Cytometer is malfunctioning. Troubleshoot the instrument. See the
cytometer IFU for more information.

Problems using the reagent on BD FACSLyric™ flow cytometers

Problem Possible cause Solution

Not enough cells of interest are
acquired.

Cell concentration was too low. Centrifuge specimen and resuspend it
at a higher concentration. Repeat
staining and acquisition.

The default setting of 100,000 events
acquired is too low.

Change the number of events
acquired. Repeat staining and
acquisition. See the BD OneFlow™
Application Guide for Chronic
Lymphoproliferative Diseases for
BD FACSLyric™ Flow Cytometers.

The FSC-A vs SSC-A dot plot is
abnormal.

Cytometer needs adjusting. Contact BD Biosciences.

The csv file and report are not
exported automatically.

The reagent lot number and
expiration date were not added to the
Library.

1. Add the reagent lot number and
expiration date to the Library.

2. Export the csv file and the report
PDF manually. See the
BD FACSLyric™ System
Instructions For Use.

Problems using the reagents on BD FACSCanto™ II flow cytometers

Problem Possible cause Solution

The resolution between debris and
lymphocytes is poor.

Instrument settings are
inappropriate.

Follow proper instrument setup
procedures. See the Instrument Setup
Guide for BD OneFlow™ Assays.

Some of the dot plots are dimmed. FSC-H and SSC-H were not selected
when the application settings were
created.

Check that FSC-H and SSC-H are
selected on the Parameters tab of
theInspector.

The barcode on the BD OneFlow™
tube label cannot be scanned.

The barcode on the tube label has
been compromised.

Scan the barcode on the
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Problem Possible cause Solution

BD OneFlow™ pouch label into the
Product ID keyword field in the
Experiment Layout. Next, manually
enter a semicolon (;) followed by the
six-digit tube-specific ID, found
adjacent to the barcode on the tube
label, after the last digit of the
barcode.

The dot plots on the worksheets are
missing or the dot plots do not have
gates.

The template did not import correctly. 1. Close the current experiment.
2. Create a new experiment.
3. Re-import the BD OneFlow™ LST

template.

Some of the keywords are missing
from the statistics box in the analysis
worksheet.

BD FACSDiva™ software did not
import all of the keywords into the
panel template.

1. In the Browser, set the current
tube pointer to the tube that you
are analyzing.

2. Navigate to the analysis
worksheet.

3. Right-click the statistics box and
select Edit Stats View.

4. In the Header tab, select the All
checkbox.

5. Click OK.

The statement, For in vitro diagnostic
use, does not appear in the footer of
the analysis worksheet when it is
printed.

The paper margins in the printer
settings were changed.

1. From the BD FACSDiva™ software
menu bar, select File > Page
Setup.

2. Ensure that all of the margins are
set to 2.54 cm or 1 inch,
depending on your default
standards.

3. Click OK.
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NOTICE
EU Only: Users shall report any serious incident related to the device to the Manufacturer and National
Competent Authority.

Outside EU: Contact your local BD representative for any incident or inquiry related to this device.

Refer to the Eudamed website: https://ec.europa.eu/tools/eudamed for Summary of Safety and Performance.

WARRANTY
Unless otherwise indicated in any applicable BD general conditions of sale for non-US customers, the
following warranty applies to the purchase of these products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE QUANTITY AND CONTENTS STATED ON THE LABEL
OR IN THE PRODUCT LABELING AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR PURPOSE AND
NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF THE PRODUCTS OR REFUND OF THE PURCHASE
PRICE. BD IS NOT LIABLE FOR PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING PERSONAL
INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT.

TRADEMARKS
BD, the BD Logo, BD FACSDiva, BD FACSLyric, BD FACSuite, BD Multi-Check, BD OneFlow, FACS, FACSCanto,
Horizon and Vacutainer are trademarks of Becton, Dickinson and Company or its affiliates. All other
trademarks are the property of their respective owners. © 2022 BD. All rights reserved.

Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare and
Carnegie Mellon University, and is made and sold under license from GE Healthcare. This product is licensed
for sale only for in vitro diagnostics. It is not licensed for any other use. If you require any additional license to
use this product and do not have one, return this material, unopened, to BD Biosciences, 2350 Qume Drive,
San Jose, CA 95131, and any money paid for the material will be refunded.

The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property of the EuroFlow
Consortium and cannot be reproduced or published without prior written permission from the EuroFlow
coordinator (euroflow.org).

HISTORY
Revision Date Changes made

23-15586-02 2020-05 Revised to support using the product on BD FACSLyric™ flow cytometers.

23-15586-03 2021-01 Revised to support using the product with the BD FACS™ Universal Loader.

23-15586(06) 2022-06 Updated to meet requirements of Regulation (EU) 2017/746. Merged
BD OneFlow™ LST and BD OneFlow™ B-CLPD T1 IFUs to support the panel.

38

https://www.cdc.gov/infectioncontrol/guidelines/isolation/index.html
https://www.cdc.gov/infectioncontrol/guidelines/isolation/index.html
http://www.euroflow.org/


SYMBOLS GLOSSARY [L006715(06) 2021-08]
Some symbols listed below may not apply to this product.
US Customers only: For symbol glossary, refer to bd.com/symbols-glossary

Symbol Meaning
Manufacturer

Authorized representative in the European Community

Authorised representative in Switzerland

Date of manufacture

Use-by date

Batch code

Catalogue number

Serial number

Sterile

Sterilized using aseptic processing techniques

Sterilized using ethylene oxide

Sterilized using irradiation

Sterilized using steam or dry heat

Do not resterilize

Non-sterile

Do not use if package is damaged and consult instructions for use

Sterile fluid path

Sterile fluid path (ethylene oxide)

Sterile fluid path (irradiation)

Fragile, handle with care

Keep away from sunlight

Keep dry

Lower limit of temperature

Upper limit of temperature

Temperature limit

Humidity limitation

Biological risks

Do not re-use

Consult instructions for use or consult electronic instructions for use

Caution

Contains or presence of natural rubber latex

In vitro diagnostic medical device

Negative control

Positive control

Contains sufficient for <n> tests

For IVD performance evaluation only

Non-pyrogenic

Symbol Meaning

Patient number

This way up

Do not stack

Single sterile barrier system

Contains or presence of phthalate: combination of bis(2-ethylhexyl)
phthalate (DEHP) and benzyl butyl phthalate (BBP)

Collect separately
Indicates separate collection for waste of electrical and electronic equipment
required.

CE marking; Signifies European technical conformity

Device for near-patient testing

Device for self-testing

This only applies to US: “Caution: Federal Law restricts this device to
sale by or on the order of a licensed practitioner.”

Country of manufacture
“CC” shall be replaced by either the two letter or the three letter country
code.

Collection time

Cut

Peel here

Collection date

Keep away from light

Hydrogen gas is generated

Perforation

Start panel sequence number

End panel sequence number

Internal sequence number

Medical device

Contains hazardous substances

Ukrainian conformity mark

Meets FCC requirements per 21 CFR Part 15

UL product certification for US and Canada

Unique device identifier
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CONTACT INFORMATION

Becton, Dickinson and Company
BD Biosciences
2350 Qume Drive
San Jose, California 95131 USA

Becton Dickinson Ireland Ltd.
Donore Road, Drogheda
Co. Louth, A92 YW26
Ireland

BD Switzerland Sàrl
Terre Bonne Park – A4
Route de Crassier 17
1262 Eysins, Switzerland

BD Biosciences
European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com

Australian and New Zealand Distributors:

Becton Dickinson Pty Ltd.
66 Waterloo Road
Macquarie Park NSW 2113
Australia

Becton Dickinson Limited
14B George Bourke Drive
Mt. Wellington Auckland 1060
New Zealand

Technical Service and Support: Contact
your local BD representative or
bdbiosciences.com.

ClinicalApplications@bd.com

eifu.bd.com
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